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Chapter 494

Paired Z-Tests for
Non-Inferiority
Introduction
This procedure computes power and sample size for non-inferiority tests in paired designs in which the paired
differences are distributed as a normal random variable and the standard deviation is known.
The details of sample size calculation for the paired design are presented in the Paired Z-Tests chapter and they
will not be duplicated here. This chapter only discusses those changes necessary for non-inferiority tests. Sample
size formulas for non-inferiority tests of a single mean are presented in Chow et al. (2018) page 43.
The one-sample z-test is used to test whether a population mean is different from a specific value. When the data are
differences between paired values, this test is known as the paired z-test.

Paired Designs
Paired data may occur because two measurements are made on the same subject or because measurements are made
on two subjects that have been matched according to other variables. Hypothesis tests on paired data can be analyzed
by considering the difference between the paired items as the response. The distribution of differences is usually
symmetric. In fact, the distribution must be symmetric if the individual distributions of the two items are identical.
Hence, the paired z-test is appropriate for paired data even when the distributions of the individual items are not
normal.

The Statistical Hypotheses
Both non-inferiority and superiority tests are examples of directional (one-sided) tests and their power and sample
size could be calculated using the One-Sample Z-Tests procedure. However, at the urging of our users, we have
developed this procedure which provides the input and output options that are convenient for non-inferiority tests
for paired data. This section will review the specifics of non-inferiority testing.
Remember that in the usual z-test setting with 𝛿𝛿 defined as the mean paired difference, the null (𝐻𝐻0 ) and
alternative (𝐻𝐻1 ) hypotheses for one-sided upper-tail tests are defined as
𝐻𝐻0 : 𝛿𝛿 ≤ 𝛿𝛿0

versus

𝐻𝐻1 : 𝛿𝛿 > 𝛿𝛿0

Rejecting 𝐻𝐻0 implies that the mean is larger than the value 𝛿𝛿0 . This test is called an upper-tail test because 𝐻𝐻0 is
rejected in samples in which the mean of paired differences is larger than 𝛿𝛿0 .
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The lower-tail test is
𝐻𝐻0 : 𝛿𝛿 ≥ 𝛿𝛿0

versus

𝐻𝐻1 : 𝛿𝛿 < 𝛿𝛿0

Non-inferiority tests are special cases of the above directional tests. It will be convenient to adopt the following
specialize notation for the discussion of these tests.
Parameter
𝛿𝛿

PASS Input/Output Interpretation
𝛿𝛿
Population mean paired difference. This is the mean of paired
differences in the population. This parameter will be estimated by the
study.

𝛿𝛿1

𝛿𝛿1

𝑀𝑀𝑁𝑁𝑁𝑁

Actual paired difference at which power is calculated. This is the value
of the mean paired difference at which power is calculated.

NIM

Margin of non-inferiority. This is a tolerance value that defines the
magnitude of difference that is not of practical importance. This may be
thought of as the largest difference that is considered to be trivial. The
sign is determined by the specific design. This value is used to compute
the bound, 𝛿𝛿0 .

Non-Inferiority Tests
A non-inferiority test tests that the mean difference is not less than (or greater than) zero by more than a small
non-inferiority margin. The actual direction of the hypothesis depends on the whether higher values of the
response are good or bad.

Case 1: High Values Good
In this case, higher values are better. The hypotheses are arranged so that rejecting the null hypothesis implies that
the mean difference no less than a small amount below zero. The value of 𝛿𝛿 at which power is calculated is often
set to zero. The null and alternative hypotheses with 𝛿𝛿0 = −|𝑀𝑀𝑁𝑁𝑁𝑁 | are

𝐻𝐻0 : 𝛿𝛿 ≤ −|𝑀𝑀𝑁𝑁𝑁𝑁 |

versus

Case 2: High Values Bad

𝐻𝐻1 : 𝛿𝛿 > −|𝑀𝑀𝑁𝑁𝑁𝑁 |

In this case, lower values are better. The hypotheses are arranged so that rejecting the null hypothesis implies that
the mean of the treatment group is no more than a small amount above the reference value. The value of 𝛿𝛿 at
which power is calculated is often set to zero. The null and alternative hypotheses with 𝛿𝛿0 = |𝑀𝑀𝑁𝑁𝑁𝑁 | are

𝐻𝐻0 : 𝛿𝛿 ≥ |𝑀𝑀𝑁𝑁𝑁𝑁 |

versus

𝐻𝐻1 : 𝛿𝛿 < |𝑀𝑀𝑁𝑁𝑁𝑁 |
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Paired Z-Test Statistic
The paired z-test assumes that the paired differences, 𝑋𝑋𝑖𝑖 , are a simple random sample from a population of
normally-distributed difference values that all have the same mean and variance (known). This assumption
implies that the data are continuous and their distribution is symmetric. The calculation of the z-test proceeds as
follows
𝑧𝑧 =

where

𝑋𝑋� − 𝛿𝛿0
𝜎𝜎⁄√𝑛𝑛

∑𝑛𝑛𝑖𝑖=1 𝑋𝑋𝑖𝑖
𝑛𝑛
and 𝛿𝛿0 is the value of the mean hypothesized by the null hypothesis which depends on the magnitude and sign of
𝑀𝑀𝑁𝑁𝑁𝑁 .
𝑋𝑋� =

The significance of the test statistic is determined by computing the p-value. If this p-value is less than a specified
level (usually 0.05), the hypothesis is rejected. Otherwise, no conclusion can be reached.

Power Calculation for the Paired Z-Test
When the standard deviation is known, the power is calculated as follows for a directional alternative (one-tailed
test) in which 𝛿𝛿1 > 𝛿𝛿0 .
1. Find 𝑧𝑧𝛼𝛼 such that 1 − Φ(𝑧𝑧𝛼𝛼 ) = 𝛼𝛼, where Φ(𝑥𝑥) is the area to the left of x under the standardized normal
curve.
2. Calculate: 𝑋𝑋1 = 𝛿𝛿0 + 𝑧𝑧𝛼𝛼

3. Calculate: 𝑧𝑧1 =

𝑋𝑋1 −𝛿𝛿1
𝜎𝜎
√𝑛𝑛

.

𝜎𝜎

√𝑛𝑛

.

4. Power = 1 − Φ(𝑧𝑧1 ).

Procedure Options
This section describes the options that are specific to this procedure. These are located on the Design tab. For
more information about the options of other tabs, go to the Procedure Window chapter.

Design Tab
The Design tab contains most of the parameters and options that will be of interest.

Solve For
Solve For
This option specifies the parameter to be calculated from the values of the other parameters. Under most
conditions, you would select either Power or Sample Size.
Select Sample Size when you want to determine the sample size needed to achieve a given power and alpha error
level.
Select Power when you want to calculate the power.
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Test
Higher Means Are
This option defines whether higher values of the response variable are to be considered better or worse. The
choice here determines the direction of the non-inferiority test. Note that δ is the population mean of paired
differences.
•

Better (H1: δ > -NIM)
If higher means are Better the null hypothesis is H0: δ ≤ -NIM, and the alternative hypothesis is
H1: δ > -NIM.

•

Worse (H1: δ < NIM)
If higher means are Worse the null hypothesis is H0: δ ≥ NIM, and the alternative hypothesis is H1: δ < NIM.

Population Size
This is the number of subjects in the population. Usually, you assume that samples are drawn from a very large
(infinite) population. Occasionally, however, situations arise in which the population of interest is of limited size.
In these cases, appropriate adjustments must be made.
When a finite population size is specified, the standard deviation is reduced according to the formula:
𝑛𝑛
𝜎𝜎12 = �1 − � 𝜎𝜎 2
𝑁𝑁
where n is the sample size, N is the population size, 𝜎𝜎 is the original standard deviation, and 𝜎𝜎1 is the new
standard deviation.
𝑛𝑛

The quantity n/N is often called the sampling fraction. The quantity �1 − � is called the finite population
𝑁𝑁
correction factor.

Power and Alpha
Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis,
and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null
hypothesis is not rejected.
Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now,
0.90 (Beta = 0.10) is also commonly used.
A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.
Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true
null hypothesis is rejected.
Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that
about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents
the risk of a type-I error you are willing to take in your experimental situation.
You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.
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Sample Size
N (Sample Size)
This option specifies one or more values of the sample size, the number of individuals in the study. This value
must be an integer greater than one. You may enter a list of values using the syntax 50 100 150 200 250 or 50 to
250 by 50.

Effect Size – Means
NIM (Non-Inferiority Margin)
This is the magnitude of the margin of non-inferiority for the mean of paired differences. It should be entered as a
positive number. If a negative value is entered, the absolute value is used.
When higher means are better, this value is the distance below zero for which the new treatment will still be
considered non-inferior to the standard treatment.
When higher means are worse, this value is the distance above zero for which the new treatment will still be
considered non-inferior to the standard treatment.
δ1 (Mean of Paired Differences)
Enter a value (or range of values) for the mean of paired differences at which power and sample size are
calculated. This value indicates the minimum detectible paired difference.
For non-inferiority tests, this value is often set to 0. When higher means are better, this value should be greater
than -NIM. When higher means are worse, this value should be less than NIM.

Effect Size – Standard Deviation
σ (Std Dev of Paired Differences)
Enter the known standard deviation of the paired differences (must be positive).
PASS includes a special tool for estimating the standard deviation. This tool may be loaded by pressing the SD
button. Refer to the Standard Deviation Estimator chapter for further details.
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Example 1 – Power Analysis
Suppose that a test is to be conducted to determine if a new cancer treatment adversely affects the mean bone
density. The adjusted mean bone density (AMBD) in the population of interest is 0.002300 gm/cm. Clinicians
decide that if the treatment reduces AMBD by more than 5% (0.000115 gm/cm), it poses a significant health
threat. They also want to consider what would happen if the margin of non-inferiority is set to 2.5% (0.0000575
gm/cm). The standard deviation of paired differences is 0.000300 gm/cm.
Following accepted procedure, the analysis will be a non-inferiority test using the paired z-test at the 0.025
significance level. Power is to be calculated assuming that the new treatment has no effect on AMBD. Several
sample sizes between 20 and 300 will be analyzed. The researchers want to achieve a power of at least 90%. All
numbers have been multiplied by 10000 to make the reports and plots easier to read.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Paired Z-Tests for Non-Inferiority procedure window by expanding Means, then Paired
Means, then clicking on Non-Inferiority, and then clicking on Paired Z-Tests for Non-Inferiority. You may
then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing
Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Power
Higher Means Are ................................... Better (H1: δ > -NIM)
Population Size ....................................... Infinite
Alpha ....................................................... 0.025
N (Sample Size)...................................... 20 40 60 80 100 150 200 300
NIM (Non-Inferiority Margin) ................... 0.575 1.15
δ1 (Mean of Paired Differences) ............. 0
σ (Std Dev of Paired Differences)........... 3

Annotated Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Higher Means are Better
Hypotheses: H0: δ ≤ -NIM vs. H1: δ > -NIM
Mean
Non-Inferiority
of Paired
Margin Differences
Power
N
-NIM
δ1
0.13506
20
-0.575
0.000
0.22730
40
-0.575
0.000
0.31728
60
-0.575
0.000
0.40298
80
-0.575
0.000
0.48273 100
-0.575
0.000
0.65079 150
-0.575
0.000
0.77356 200
-0.575
0.000
0.91305 300
-0.575
0.000
0.40298
20
-1.150
0.000
0.67884
40
-1.150
0.000
0.84359
60
-1.150
0.000
0.92904
80
-1.150
0.000
0.96949 100
-1.150
0.000
(report continues)

Standard
Deviation
σ
3.0
3.0
3.0
3.0
3.0
3.0
3.0
3.0
3.0
3.0
3.0
3.0
3.0

Alpha
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025
0.025

Beta
0.86494
0.77270
0.68272
0.59702
0.51727
0.34921
0.22644
0.08695
0.59702
0.32116
0.15641
0.07096
0.03051
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Report Definitions
Power is the probability of rejecting a false null hypothesis. It should be close to one.
N is the sample size, the number of subjects (or pairs) in the study.
-NIM is the magnitude and direction of the margin of non-inferiority. Since higher means are better, this
value is negative and is the distance below the reference value that is still considered non-inferior.
δ is the mean of paired differences.
δ1 is the value of the mean of paired differences at which power and sample size are calculated.
σ is the standard deviation of paired differences for the population.
Alpha is the probability of rejecting a true null hypothesis. It should be small.
Beta is the probability of accepting a false null hypothesis. It should be small.
Summary Statements ─────────────────────────────────────────────────────────
A sample size of 20 achieves 14% power to detect non-inferiority using a one-sided paired
z-test when the non-inferiority margin is -0.575 and the actual mean of paired differences is
0.000. The a known standard deviation of paired differences is 3.0. The significance level
(alpha) of the test is 0.025.

The above report shows that for NIM = 1.15, the sample size necessary to obtain 90% power is just under 80.
However, if NIM = 0.575, the required sample size is about 300.
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Example 2 – Finding the Sample Size
Continuing with Example 1, the researchers want to know the exact sample size for each value of NIM.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Paired Z-Tests for Non-Inferiority procedure window by expanding Means, then Paired
Means, then clicking on Non-Inferiority, and then clicking on Paired Z-Tests for Non-Inferiority. You may
then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing
Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Higher Means Are ................................... Better (H1: δ > -NIM)
Population Size ....................................... Infinite
Power ...................................................... 0.90
Alpha ....................................................... 0.025
NIM (Non-Inferiority Margin) ................... 0.575 1.15
δ1 (Mean of Paired Differences) ............. 0
σ (Std Dev of Paired Differences)........... 3

Output
Click the Calculate button to perform the calculations and generate the following output.

Numeric Results
Numeric Results ────────────────────────────────────────────────────────────
Higher Means are Better
Hypotheses: H0: δ ≤ -NIM vs. H1: δ > -NIM

Power
0.90097
0.90195

Mean
Non-Inferiority
of Paired
Margin Differences
N
-NIM
δ1
287
-0.575
0.000
72
-1.150
0.000

Standard
Deviation
σ
3.0
3.0

Alpha
0.025
0.025

Beta
0.09903
0.09805

This report shows the exact sample size requirement for each value of NIM.
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Example 3 – Validation using Chow, Shao, Wang, and Lokhnygina
(2018)
Chow, Shao, Wang, and Lokhnygina (2018) page 46 has an example of a sample size calculation for a paired noninferiority z-test. Their example obtains a sample size of 7 when δ1 = 0.5, NIM = 0.5, σ = 1, Alpha = 0.05, and
Power = 0.80.

Setup
This section presents the values of each of the parameters needed to run this example. First, from the PASS Home
window, load the Paired Z-Tests for Non-Inferiority procedure window by expanding Means, then Paired
Means, then clicking on Non-Inferiority, and then clicking on Paired Z-Tests for Non-Inferiority. You may
then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing
Open Example Template.
Option

Value

Design Tab
Solve For ................................................ Sample Size
Higher Means Are ................................... Better (H1: δ > -NIM)
Population Size ....................................... Infinite
Power ...................................................... 0.80
Alpha ....................................................... 0.05
NIM (Non-Inferiority Margin) ................... 0.5
δ1 (Mean of Paired Differences) ............. 0.5
σ (Std Dev of Paired Differences)........... 1

Output
Click the Calculate button to perform the calculations and generate the following output.
Numeric Results ────────────────────────────────────────────────────────────
Higher Means are Better
Hypotheses: H0: δ ≤ -NIM vs. H1: δ > -NIM

Power
0.84156

Mean
Non-Inferiority
of Paired
Margin Differences
N
-NIM
δ1
7
-0.5
0.5

Standard
Deviation
σ
1.0

Alpha
0.050

Beta
0.15844

PASS also obtains a sample size of 7.
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